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The ALICE Receptionist Directory is the most advanced office lobby greeting system available with a 

large range of features and options. 

The ALICE Receptionist Directory (ARD) software is an automated office building greeting system 

which greets visitors to a building or lobby area and allows them to communicate with employees 

who are in the building, out of office, or located at remote facilities. 

The ALICE Receptionist System consists of the ALICE Directory machine and the various Client 

applications that receive calls from the Directory. Communication methods between the Directory 

and Clients currently include: Audio-Only, 1-Way Video and 2-Way Video. 

The ALICE Receptionist System offers companies a wide range of configurable options to control 

how visitors interact with the system and company employees. 

Definitions 

APPLICATIONS: 

ALICE Receptionist Directory: (Also referred to in this document as the Directory or ARD.) The ARD 

is the Directory unit which is typically installed in the company’s building foyer or lobby area. The 

minimum ARD unit configuration includes a touchscreen monitor/PC combination with an 

integrated or attached camera and speakers. The Directory requires an internet connection and/or a 

connection to the company’s Local Area Network (LAN), depending on which communication options 

are in use. 

ALICE Receptionist Client: (Also referred to in this document as the Client or ARC.) The Client is the 

software application that is installed on the user’s computer to communicate with the visitors using 

the Directory. 

ALICE Directory Configuration: This is the settings application that a company uses to configure and 

set preferences for their ALICE Receptionist Directory system. 

ALICE Receptionist Web Admin Portal: This is the administration website that the ALICE Receptionist 

Administrator will use to configure system-wide and default settings. 
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ALICE Admin Application for Windows: This is the administration application that is installed 

completely on a company PC, as an alternative to the Web Admin Portal, to configure system-wide 

and default settings.  

TERMS: 

Visitors: These individuals interact with the Directory. 

Users: (Also referred to in this document as Employees.) These are individuals, typically employees, 

who receive calls from the Directory and interact with visitors who are using the Directory. 

Operator: The Operator is a designated single user assigned as the default contact who will receive 

calls from the Directory when the “Operator Mode” feature is enabled. 

ALICE Receptionist Administrator: The individual within your organization who has been designated 

as the Administrator for the ALICE Receptionist system. This individual will have login credentials to 

the ALICE Receptionist Web Admin portal or the Admin App for Windows, as applicable. 

Acronyms, Abbreviations 

Admin = ALICE Receptionist Administrator 

Admin Portal = ALICE Receptionist Web Admin Portal 

Admin App= ALICE Admin Application for Windows 

Directory or ARD= ALICE Receptionist Directory 

Client or ARC= ALICE Receptionist Client 
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The ALICE Directory user interface is designed to present information in an attractive and intuitive 

manner.  

 

 

 

 

 

 

 

 

 

The Alice Directory screen can be segmented into 4 sections, outlined below.   
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ALICE Video Section 

The ALICE Video section of the Directory interface is where all ALICE video clips are played. This 

includes the pre-recorded ALICE videos as well as the live-streaming video displayed during a video 

call. 

 

 

 

 

 

 

 

 

 

ALICE is configured to play a video of Alice waiting for visitor interaction before she starts providing 

information or connecting the visitor with an employee.  
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Main Menu Section 

The Main Menu section consists of up to six (6) main menu buttons that remain static on the 

Directory screen at all times. These buttons provide visitors easy and quick access to the features 

that are most important for their experience with ALICE. 

 

 

 

 

 

 

 

 

Configuring Main Menu Button 

The Main Menu buttons are configurable and custom buttons can be defined by the ALICE system 

administrator for each company.  

 Company / Department / Employee: There is only one fixed button on the menu. When 

this button is pressed, it will display a list of cards on the right of the screen for the building. 

The list of cards will either be a list of companies, departments, or employees for the 

building. As such the default caption of the first button will either be “Company List” 

“Department List” or “Employee List”. The ALICE system administrator determines which of 

those directories will be displayed. The button can also be changed by the administrator. 

This button behavior is based on the check boxes that are checked in the Group and Sort 

Settings on the Layout tab in the ALICE Configuration application.  
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o Show Company Directory: If selected, a Card will be loaded for each organization 

configured in the ALICE Admin Portal or Admin App for your account. 

o Show Department Directory: If selected, a Card will be loaded for each Department 

configured in the ALICE Admin Portal or Admin App for your account. 

o  Show Employees By: Employees are always listed in the Directory. You can specify 

the default sort order (alphabetical by first or last name) for the employees. 

 

Configuring Optional Buttons 

There are a number of optional buttons which can be turned on and off by the administrator. These 

buttons have a predefined behavior when pressed. 

 Call Receptionist:  This button will be displayed if the Receptionist option under Display 

Buttons on the Menu Buttons tab in the ALICE Configuration application has been checked. 

 

o The employee designated to be reached by this 

button will be assigned in the Admin Portal or 

Admin App. Select the Directory or Directories 

tab. In the list of Directories, choose the Directory 

you are configuring and select Edit. Assign an 

employee as the Receptionist in this window. 
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 Call Security: This button will be displayed if the Security option under Display Buttons on 

the Menu Buttons tab in the ALICE Configuration application has been checked. 

 

o The employee designated to be 

reached by this button will be 

assigned in the Admin Portal or 

Admin App. Select the Directory or 

Directories tab. In the list of 

Directories, choose the Directory 

you are configuring and select Edit. 

Assign an employee as Security in 

this window. 

 

 Help: This button will play the standard 

ALICE Help video. This is a short video 

(about 30 seconds) that provides a brief 

instruction to a visitor on how to use the 

system. 

 Events: This button will display the Events screen. Configure the Events screen using the 

Events Tab in the ALICE Configuration application. 
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Custom Button Ideas 

Custom buttons are buttons that the ALICE system administrator can create and configure. There 

are a number of different behaviors that a custom button can be configured for. These include: 

 Open a URL  

o HTML Documents  

o Web pages 

o ALICE Widget 

 Photo gallery widget 

 Weather widget 

 Induction Screens 

o Interactive Wayfinding Map 

 Open Media File 

o Images 

o Videos 

In addition to being able to configure the custom button behavior, the administrator can configure 

the button caption, icon, position and appearance (colors). Below are some examples of custom 

buttons and how they would be configured: 

 Building Map: When the Building Map button is pressed, an image will display that has been 

set in the ALICE 

Configuration 

application. This 

image can be of a 

building, campus or 

any other image the 

company wishes to 

display when the 

Building Map button 

is pressed. 
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o This button is customized under the Menu Buttons tab by selecting “Add Button”.  

Give the button a name under “Button Text” and then use the “Button Functionality” 

menu to set the website or image that will open when this button is pressed. 

o Give this button 

additional customization 

by adding an icon next to 

the text. 

 

 

 

 

o After you have created this button, it can be set as your home screen on the Layout 

tab of the ALICE Configuration settings. Instead of a Directory contact list shown on 

the right side of the Main Menu, the Building Map can be shown as the reset screen 

after a Visitor has interacted with the Directory. 
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 Information:  When the Information button is pressed, an image or website can be 

launched based on your settings in the ALICE Configuration application. The image or html 

site will load on the right side of the screen. Visitors can interact with any clickable area of 

the html page displayed. 

 

 

 

 

 

 

 

 

o This button is customized under the Menu Buttons tab by selecting “Add Button”. 

Follow the same instructions as for adding a Building Map to customize this button 

or even set this as your home screen. 
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Navigation Menu Section 

The Navigation Menu allows visitors to filter and navigate through multiple pages when there are 

more Contact Cards than will display on a single page. 

 

 

There are seven (7) Navigation Menu buttons: 

 This button only appears if the system has been configured 

to display Companies or Departments. When pressed it will 

return the user up one level. 

 Move to the previous page of cards. 

  Display all Cards (no filtering). 

  Display only Cards A–H. 

 Display only Cards I–P. 

 Display only Cards Q–Z. 

 Move to the next page of cards. 

 

To assign whether this tool will be displayed on 

your Directory, access the Layout tab of the ALICE 

Configuration application. Uncheck the Show 

Navigation Menu option to remove the menu. 

 



 

  

Version 3.7.4 Page 13 of 29 

DIRECTORY USER MANUAL 

Contact Card Section 

The Contact Card section is located on the right (or bottom in Portrait layout) of the screen. This 

contains the Contact Cards that a visitor can use to contact an Employee. If the Directory is for a 

multi-tenant building and Companies are turned on in the ALICE Configuration, a list of companies 

or organizations will be the top level shown in the Contact Card section. Users can simply click on 

the card for the company or organization they want to visit in order to see a list of employees for 

that group. 

 

Once a Company card is pressed, a list of Employees for that company will be displayed. 
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Card Actions:  

Each Card can be configured for a Card Action Type. The Card Action determines the behavior of the 

card once it is clicked on. Valid Card Action Types and their behavior are as follows: 

 None: This is the default behavior for Organization and Department cards. When Action 

Type is set to none on the Admin Portal the button will simply drill down to display a list of 

entities (departments or employees) that below to it. 

 Call: For Organization and Department Cards this will call the employee assigned to as the 

Default Employee for this card. For Employee Cards, this will call the employee. 

 URL: For all card types, this will open a Browser to the URL specified for the card 

 Image: For all card types, this will display a static image on the Directory 

 Video: For all card types, this will play a video on the Directory 

Additional features in the Contact Card section include: 

 

 

 

 

The Sorted By button: 

When Company cards are displayed, this will show 

Company Name instead of Sorted By.  

When Employee cards are displayed, this button 

can be pressed to toggle between Sorted by Last 

Name and Sorted by First Name. 

 
The Page Number label displays the current page 

and total number of pages available. 
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The ALICE Receptionist System includes a long list of features that is constantly being added to and 

improved upon by the ALICE Receptionist team. Not all features are enabled for every installation. 

Companies determine which features suit their office environment at the time of purchase and the 

ALICE Receptionist System is configured to match their specific needs.  

Should additional features be desired after the initial installation, this can be accomplished for most 

features by using the Admin Portal, Admin App, Configuration or Client applications. 

The following is a list of highlighted features available within the ALICE Receptionist System: 

Communication Preferences 

The ALICE Directory can be configured to allow three (3) different forms of communication between 

the visitor and employee. Each communication option provides its own set of benefits and 

interaction experiences for both the employee and the visitor. These communication preference 

options are: 

 Phone (audio-only): Employee and visitor communicate as they would during a normal 

phone call, with no video for either party. 

 

Interaction Experience: When the visitor touches a name on the Directory to call an 

employee, the Directory sends a call to the employee’s designated phone number. The 

phone number can be any valid phone number including office, home, remote location or 

cell phone. The visitor’s audio will be captured by the Directory camera and does not require 

the use of a phone. 

 One-Way Video: The employee sees video of the visitor; the visitor does not see video of the 

employee. The employee’s phone (office, home, remote location or cell phone) is configured 

to ring when the call comes in from the Directory and the employee can speak with the 

visitor over the phone while seeing the visitor using the ALICE Client application. 

 

Interaction Experience: When the visitor touches a name on the Directory to call an 

employee, the Directory sends the video of the visitor to the employee’s ALICE Client 

application and the audio to the employee’s phone. The employee will be able to view the 

visitor on the ALICE Client application at the same time their phone will ring with the audio 

portion of the call. To answer the call the employee simply picks up the phone call and clicks 
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the answer button on the ALICE Client application. When done, the employee simply hangs 

up the phone or presses the hang up button in the ALICE Client application. 

 Video: Both employee and visitor can see and hear each other using video. 

 

Interaction Experience: When the visitor touches a name on the Directory to call an 

employee, the Directory will send the video and audio of the visitor to the employee’s ALICE 

Client application. If the employee accepts the call from the visitor, the employee’s video and 

audio will be sent back to the Directory. Both the employee and visitor communicate with 

each other via live video streaming. 

 Split Call: The employee sees video of the visitor and the visitor sees video of the employee. 

The employee’s phone (office, home, remote location or cell phone) is configured to ring 

when the call comes in from the Directory and the employee can speak with the visitor over 

the phone while seeing the visitor using the ALICE Client application. 

Interaction Experience: When the visitor touches a name on the Directory to call an 

employee, the Directory sends the video of the visitor to the employee’s ALICE Client 

application and the audio to the employee’s phone. The employee will be able to view the 

visitor on the ALICE Client application at the same time their phone will ring with the audio 

portion of the call. To answer the call the employee simply picks up the phone call and clicks 

the answer button on the ALICE Client application. The employees video will then show up 

on the ALICE Directory screen. 

Setting an Employee’s Default Communication Preference: Employees’ default communication 

preferences are automatically recognized by the system based on the Contact Number/Address 

entry on the Employee or Employees tab on the Admin App or the Admin Portal. The Directory will 

use the selected communication preference for each user, allowing for a customized experience.  

For Audio-only communications, the employee’s phone number 

will be entered. For VoIP systems, only the employee’s extension is 

needed. This field should include only the phone number, the 

extension, or the 

phone number plus 

extension. 

 

                                                                                                              

Admin App  Admin Portal  
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For Video communications using the ALICE Client 

software, enter the SIP address:  

            

For One-Way Video communications enter both your SIP 

address and the phone number that will be used for the 

audio portion of the call. The SIP address should go in the 

Phone / Extension field as shown here: 

 

 

For Video or Audio calls to 3
rd

 party 

softphones, enter the SIP address. Please 

note that 3
rd

 party softphones require the “Bria_sip:” at the beginning of the SIP address. 

Admin Portal  

Admin App 

Admin Portal 

Admin App  
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We recommend the use of the BRIA softphone by Counterpath if you choose to use a 3
rd

 party 

softphone. The Bria softphone is available on iPhones, iPads, Macs, Android smartphones, Android 

tablets and Windows PCs. 

Find pricing and information at http://www.counterpath.com/softphone-products.html 
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Motion Detection 

Motion Detection enables the ALICE Directory to respond to detected movement in the area viewed 

by the ALICE Directory camera. The responsiveness of the Directory depends on various options 

selected by the Administrator that determine how their Directory interacts with visitors. 

This setting can be enabled in the Options tab of the ALICE Configuration program. 

 

Configuring the Motion Detection behavior: 

 Motion Detection Grace Period: This is the time period, in seconds, that the Motion 

Detection will wait after it has recognized a visitor before ALICE starts looking for movement 

again. We recommend this be at least 60 seconds to avoid having the same guest greeted 

multiple times. Depending on how quickly your visitors are met by employees and delivered 

out of the lobby area, you may want to increase this number to allow for more time. 

 Set Region: Allow you to set the area viewed by the camera that you want to limit motion 

detection to. 

 Motion Processing: Changes the type of processing used for motion detection. 

 Test Current Settings: Check this option to turn on the camera and perform motion 

detection sensitivity testing. Each time the camera sees motion it will display a “Motion 

Detected” message.  

 Exit Screen Saver on Motion Detection: Check this box to instruct the Directory to wake 

the machine when it detects a visitor. This allows the Directory to use a screen saver but still 

greet visitors as they walk up to the Directory. 
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 Display directory on Motion detection: This will cause the Company / Department or 

Employee directory to display when the Motion Detection senses movement, even when the 

Home Screen on the layout tab is set to something other than the Directory screen. 

 Auto focus compensation delay seconds: Some cameras auto-focus every time they are 

turned on which causes false positive motion detection. To avoid this enter a number of 

seconds they system should delay before it starts looking for motion detection after the 

camera is turned on.  6 seconds is normally a sufficient amount of time. 

 Motion Detection Sensitivity: Adjust the slider to set the sensitivity level for the Motion 

Detection. A higher number means motion will be picked up further away from the camera. 

A lower number means a visitor will need to get closer to the camera for the motion 

detection to be activated. 

Other factors in the Directory behavior regarding Motion Detection: 

 Self Service Mode: While in Self Service Mode, the standard behavior for a Directory that 

has Motion Detection enabled is to play the “Welcome” greeting video when the Directory 

identifies a visitor. The system then waits for the visitor to initiate a call to a contact listed in 

the ALICE Directory. 

 Operator Mode: If the system is in Operator Mode, the behavior of Motion Detection is to 

immediately contact the designated Operator instead of greeting the visitor. A notification 

message will display on the screen while the Directory attempts to contact the Operator. 

Operator Mode is described in more detail in the following section. 
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Operator Mode 

In Operator Mode, the ALICE Directory does not require the visitor to touch the screen to contact an 

employee. Instead, the Directory uses motion detection to recognize the visitor and automatically 

connects the visitor with a designated employee. This employee is referred to as the Operator. The 

following is a typical visitor experience with the Directory while it is in Operator Mode: 

 Visitor enters building lobby. 

 The Directory’s motion detection sees the visitor and calls the employee who has been 

designated as the default Operator on the Admin Portal or Admin App. 

o If the employee is setup for 1-Way or 2-Way Video they will see the visitor in the 

lobby. 

o If the employee is set up for phone (audio-only) communication, the Directory will 

call the employee’s phone. 

 If the employee accepts the call, the Directory connects the visitor with the employee. This 

happens without the visitor initiating any interaction with the Directory. 

 

Turning on Operator Mode:  

The ALICE Receptionist Administrator can turn the 

Operator Mode on and off from the Admin Portal or the 

Admin App. 

From the Admin Portal: Log in and select the desired 

Directory. Ensure that employees have been assigned to 

this Directory, and assign an employee to act as Operator 

from the drop down list. Then check the Operator Mode 

box and the Publish box. Complete the process by clicking 

Update. If the Publish box was not checked, these changes 

will be saved but they will not be transferred to the 

Directory. The next time the Directory is started it will 

operate in Operator Mode. To turn off Operator mode, 

unclick Operator Mode, click Publish, and select Update. 
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From the Admin App: Log in and select the desired Directory. Select an employee for the Operator 

Contact field and press the Update button to save your selection. 
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Video Mail 

Visitors are able to record Video Mail messages that can be left for unavailable employees who are 

using the ALICE Client application.  

When a visitor attempts to contact an employee who is using the 

ALICE Client but the employee is not available or does not accept 

the video call, ALICE will ask the visitor if they would like to leave a 

video message. 

 

 

If the visitor clicks Yes, they are instructed on how to leave a 

video message. 

After the visitor records their video message, they can press the 

Preview button to review the video, press the Send button to 

send the video to the employee, or press the Cancel button if 

they decide not to send the video message. 

 

If they press the Send or Cancel buttons they are asked to confirm their choice. 

 

 

 

 

If the visitor confirms sending the video message, it will be delivered to the employee’s email 

address. The employee can view the video by opening the video attachment in their email and 

playing it. 
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Employee Photos 

The Directory has a number of layout options that can be configured in the Directory Configuration 

program. Most of those settings are explained in the Directory Installation Manual. Here we will 

cover one of these features, the ability to display employee photos on the employee cards in the 

Directory. 

Employee pictures give the visitor a quick, visual way to locate the person they want to contact.  

In order to display employee photos in the Directory, the employee photo files must be loaded on 

the Admin portal using “Manage Photo” button on the Employee Tab. 

Considerations when loading employee photos: 

 Size: Photos should be sized to 115x115 pixels. 

 Format: All photos must be uploaded in a .jpg image format. 

 When Show Photos is enabled, employees who do not have a valid photo file 

stored on the Directory will have the no photo image displayed on their card in 

place of an employee photo. 

 

Turn Employee Photos On and Off 

 To turn on employee photos, simply check the Show 

Photos check box on the Layout tab of the Directory 

Configuration program and restart the Directory. To turn 

this feature off, simply uncheck the check box and restart 

the Directory to activate the change. 
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Visitor Check-In / Check-Out 

The Visitor Check-in / Check-Out feature provides a way for visitors to Check-In and Check-Out of a 

building using the ALICE Receptionist system. 

 

For details on configuring and using the ALICE Visitor Check-In feature see the ALICE Visitor Check-In 

manual. 

  



 

  

Version 3.7.4 Page 26 of 29 

DIRECTORY USER MANUAL 

ALICE Events 

The Alice Events feature provides a way to display a list of the day’s events on the ALICE Receptionist 

screen. 

 

Events for the current day are imported from one or more MS Outlook or Google calendars and 

displayed on the ALICE Directory screen. Visitors can use the Events page, to view Event times, 

location, details and maps. If the ALICE Directory is configured to use the ALICE Visitor Check-In 

feature, that feature can also be launched from the Event list. 

For details on configuring and using the ALICE Events feature see the ALICE Events manual. 
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Induction Screen Widget 

The Alice Induction screens widget provides a way for businesses to control an visitor / vendor 

induction process for their buildings.  Using the ALICE Induction widget, companies can collect 

information about the visitor, the organization they represent. The induction process also can 

display documents, videos and agreements which require the visitor’s acknowledgement in order to 

complete the induction process. A record of the visitor’s information and acknowledgements is 

recorded by the ALICE Receptionist system. 

 

For details on configuring and using the ALICE Induction Widget see the ALICE Induction Widget 

manual. 
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System / Security Logs 

The Alice system logs provide a way for businesses track information about who and how people are 

using the ALICE Receptionist system. The following tracking is available in the ALICE Receptionist 

system: 

 Usage Details: Tracks what buttons are pressed on the ALICE Receptionist Directory screen. 

 Call Details: Tracks the following information about every call that is initiated by the ALICE 

Directory: 

o Call Start Time 

o Length of Call 

o Number called 

 Visitor Images: Captures 3 images of every visitor the camera sees when the Motion 

Detection feature is activated. 

 Visitor Check-In / Check-Out logs: Tracks the following information for every visitor who 

uses the Visitor Check-in and Check-out feature.  

o Visitors Name 

o Employee Visited 

o Check-In Date / Time 

o Check-Out Date / Time 

o Check-in Type (Scheduled or Self Check-in) 

Logging can be turned on in the Alice Directory Configuration application by opening the Options 

tab and selecting the information to track. Visitor Check-in / Check-out information is always tracked 

and does not have a check box to turn on or off. 
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Conclusion 

The features highlighted in this user manual only represent some of the more high-profile features 

of the ALICE Receptionist System. Information on these and other features can be found in the 

following documents: 

 ALICE Receptionist Client User Manual 

 ALICE Receptionist Client Installation Manual 

 ALICE Receptionist Directory Installation Manual 

 ALICE Receptionist Admin Portal Site Manual 

 ALICE Receptionist Admin Application for Windows 

 

Some of the features covered in these documents include: 

ALICE Receptionist Directory ALICE Receptionist Client 

 Audio feedback sound  Communication Settings 

 On-premises mail server support  Startup preferences 

 Hosted mail server support  SIP Settings 

 On-premises VoIP phone support  Alert sound preferences 

 Hosted VoIP phone service support  Status settings 

 Audio call timeout configuration  

 Employee list configuration  

 Card layout configuration 

 

ALICE Receptionist Admin Portal and Admin 

Application for Windows 

 Company account management 

 Directory management 

 Employee management 

 Department list management 

 Position / Title list management 

 Operator Mode 

 Designate employee as operator 

 Directory membership management 

 

  

 


